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LISTA DE ABREVIATURAS UTILIZADAS 

Abreviatura Descripción 

FC Fondo de Cohesión 

DG REGIO Dirección General de Política Regional y Urbana 

CE Comisión Europea 

FEDER Fondo Europeo de Desarrollo Regional 

UE Unión Europea 

RR. HH.  Recursos humanos 
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GLOSARIO DE TÉRMINOS  

Término Descripción 

Competencia 

Capacidad de aplicar o utilizar conocimientos, competencias, 

habilidades, conductas y características personales para llevar 

a cabo satisfactoriamente tareas de trabajo críticas, funciones 

específicas o asumir una función o cargo determinado. 

Marco de competencias 

Un instrumento para la gestión de recursos humanos que 

incluye conjuntos de competencias, pertinente para el 

desarrollo tanto de organizaciones como de empleados. 

Empleados del nivel de 

toma de decisiones 

(responsables de la 

toma de decisiones) 

Se trata del jefe de la institución del FEDER/FC o las personas 

que actúan en niveles de dirección estratégica relativamente 

elevados 

Marco de competencias 

de la UE 

El marco de competencias para el FEDER y el FC desarrollado 

por la DG REGIO 

Grupos de funciones 

profesionales 

Los tres tipos de puestos de empleados implicados en la 

gestión y ejecución del FEDER/FC (empleados del nivel 

operativo, empleados del nivel de supervisión y empleados del 

nivel de toma de decisiones) desarrollados teniendo en 

consideración las tareas, las subtareas y las responsabilidades 

desempeñadas en cada nivel. 

Equipo de aplicación 

El equipo perteneciente a una administración con 

responsabilidades sobre la aplicación de una evaluación de 

competencias utilizando el Marco de competencias de la UE y 

la herramienta de autoevaluación.  

Institución 

Tipos de instituciones implicadas en la gestión y ejecución del 

FEDER y el FC de conformidad con los Reglamentos: 

Organismo de coordinación, Autoridad de gestión, Autoridad 

de certificación, Organismo intermedio, Autoridad de auditoría 

o funciones de Secretaría conjunta. 

Instrumentos 
Marco de competencias de la UE y herramienta de 

autoevaluación 

Descripción del puesto 

Un documento que resume las principales responsabilidades, 

funciones y obligaciones, así como las competencias y niveles 

de dominio necesarios. 

Competencias de 

gestión 

Competencias necesarias para las funciones de gestión, 

basadas en conocimientos, habilidades y capacidades 

adquiridos. 

Competencias 

operativas 

Competencias que precisa el personal para gestionar 

correctamente las funciones asignadas en relación con la 

gestión del FEDER y el FC. 

Empleados del nivel 

operativo 

Expertos que trabajan directamente en las distintas tareas y 

subtareas en el seno de la organización. 

Competencias 

profesionales 

Competencias necesarias para la ejecución de funciones 

profesionales específicas y basadas en los conocimientos, 

habilidades y capacidades adquiridos. 

Reglamentos 
Reglamentos sobre los Fondos de Estructurales y de Inversión 

europeos para el periodo 2014-2020 
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Término Descripción 

Automatización de los 

procesos mediante la 

robótica 

Aplicación de tecnología que permite configurar software 

informático o un «robot» para captar e interpretar 

aplicaciones existentes para el procesamiento de una 

transacción, la manipulación de datos, la activación de 

respuestas y la comunicación con otros sistemas digitales. 

Autoevaluación 

Una evaluación del nivel de dominio propio con respecto a las 

competencias necesarias para la ejecución efectiva y eficiente 

de las funciones asignadas. 

Herramienta de 

autoevaluación 

(herramienta) 

Una herramienta basada en web utilizada para evaluar el nivel 

de dominio del usuario con respecto a competencias e 

identificar aquellas en las que necesita mejorar. 

Subtarea 

Una acción realizada por una autoridad (institución) o una 

persona que produce un resultado relacionado con la gestión 

del FEDER y el FC. 

Empleados del nivel de 

supervisión 

(supervisores) 

Se trata del nivel de gestión intermedio de las instituciones 

del FEDER/FC, generalmente jefes de unidades organizativas, 

responsables de un grupo de personas y no implicados 

directamente en la ejecución operativa del programa. 

Tareas 

Grupo de subtareas agrupadas según el propósito de la tarea 

y realizadas por una persona o grupo de personas en sus 

actividades diarias para garantizar la gestión del FEDER y el 

FC. 

Planes de aprendizaje y 

desarrollo 

Planes para el desarrollo de competencias basados en 

resultados de una evaluación de competencias realizada 

utilizando el Marco de competencias de la UE y la herramienta 

de autoevaluación. 
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1 INTRODUCCIÓN 

Esta Guía de usuario ha sido desarrollada por la DG Política Regional y Urbana (DG 

REGIO) de la Comisión Europea con el fin de ayudar a las administraciones participantes 
en la gestión y ejecución del FEDER y el Fondo de Cohesión a aplicar el Marco de 

competencias de la UE y la herramienta de autoevaluación («los instrumentos»). 

La Guía de usuario es el documento de orientación fundamental para la aplicación de los 

instrumentos a escala de la administración. Se recomienda a los empleados de la 
administración encargados de la aplicación de los instrumentos que lo analicen 

atentamente antes de proceder a la evaluación de competencias.  

Los contenidos de la Guía de usuario incluyen: 

 El Marco de competencias de la UE, que describe en detalle las competencias 

necesarias para la gestión y ejecución del FEDER y el Fondo de Cohesión, su 

justificación y ventajas (capítulo 2). 

 La herramienta de autoevaluación, que plasma los contenidos del Marco de 

competencias de la UE en un instrumento adecuado para la autoevaluación de 

competencias de empleados e instituciones (capítulo 2). 

 La organización del proceso de evaluación de competencias en términos de orden de 

fases y actividades y recomendaciones sobre lo que deben y no deben hacer las 

instituciones a la hora de aplicar los instrumentos (capítulo 3). 

 La elaboración de Planes de aprendizaje y desarrollo (y plantilla) para mejorar las 

competencias que requieren mejora, incluido un marco metodológico para la 

selección de las opciones de aprendizaje más adecuadas (capítulo 3). 

 Instrucciones técnicas que describen los pasos necesarios para modificar el Marco de 

competencias de la UE y la herramienta de autoevaluación (capítulo 4). 

La relación entre los contenidos mencionados se presenta en la ilustración siguiente: 
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Para comenzar, las administraciones deberán:  

 Obtener una copia de la herramienta de autoevaluación enviando una solicitud de 

nombre de usuario y contraseña a REGIO-COMPETENCY-

FRAMEWORK@ec.europa.eu, y 

 Utilizar el nombre de usuario y la contraseña en el siguiente sitio web que aloja la 

herramienta de autoevaluación:  

 https://fs26.formsite.com/form_app/FormSite?FormId=LoadLogin&Directory=sa_tools 

 

 

 

mailto:REGIO-COMPETENCY-FRAMEWORK@ec.europa.eu
mailto:REGIO-COMPETENCY-FRAMEWORK@ec.europa.eu
https://fs26.formsite.com/form_app/FormSite?FormId=LoadLogin&Directory=sa_tools
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2 JUSTIFICACIÓN Y CONCEPTOS CLAVE 

2.1 Por qué un Marco de competencias de la UE y una herramienta de 

autoevaluación 

Según ha evolucionado la política de cohesión con el tiempo, el alcance de los 
conocimientos y competencias necesarios para su ejecución se ha ampliado. A la vista de 

este hecho, la Comisión ha resaltado la necesidad de prestar apoyo a los Estados 
miembros en sus esfuerzos por fortalecer la capacidad administrativa de las 

administraciones nacionales y regionales que gestionan el FEDER y el Fondo de Cohesión 
a través de la aplicación de acciones concretas.  

El periodo de programación 2014-2020 ha introducido cambios en los reglamentos, lo 

que supone la necesidad de nuevas competencias para gestionar y ejecutar el FEDER y 
el Fondo de Cohesión. Asimismo, la gestión efectiva de los fondos exige un conjunto de 

competencias que superan los requisitos dispuestos en los reglamentos.  

En respuesta a estos desafíos, la Comisión ha desarrollado el Marco de competencias de 

la UE y la herramienta de autoevaluación como «instrumentos» prácticos con los que 
ayudar a las administraciones a reforzar su capacidad de gestionar y ejecutar el FEDER y 

el Fondo de Cohesión:  

 El Marco de competencias de la UE es un instrumento para la gestión de recursos 

humanos, que define las competencias pertinentes para el desarrollo tanto de los 

empleados como de las instituciones implicadas en la gestión y ejecución del FEDER y 

el FC.  

 La herramienta de autoevaluación se basa en los contenidos del Marco de 

competencias de la UE y se utiliza para evaluar el nivel de dominio de las 

competencias de empleados e instituciones, al mismo tiempo que aporta pruebas 

para acciones de desarrollo de competencias. 

Las ventajas fundamentales de tales instrumentos son: 

 instrumentos de refuerzo de las capacidades adaptados a las especificidades del 

FEDER y el Fondo de Cohesión; 

 oportunidad para que las administraciones mediten sobre el nivel de competencias 

tanto a nivel de empleado como de institución; 

 fuente de información sobre las necesidades de desarrollo de competencias para 

los encargados de la dirección de las instituciones; 

 pruebas para desarrollar estrategias que hagan frente a las necesidades de 

desarrollo competencial, incluido un uso más estratégico de la Asistencia técnica de 

los Fondos EIE; 

 fuente para reflexionar sobre mejoras en la estructura organizativa de la 

administración en relación con las funciones del FEDER y el FC; 

 oportunidad de debate entre empleados y supervisores con relación a los 

conocimientos técnicos y la capacidad de los empleados, así como sus puntos 

fuertes y débiles; 

 ausencia de requisitos con respecto a capacidades técnicas o costes para las 

administraciones. 

El uso de los instrumentos no es obligatorio y los resultados de la autoevaluación son 
para el uso exclusivo de las instituciones, y no servirán de base de informes a la 

Comisión. Con la misma idea, cuando los instrumentos se apliquen en una institución, se 
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recomienda mantener su uso separado de los procesos de evaluación, y tratar los 

resultados de las evaluaciones de los empleados con carácter confidencial. 

2.2 Conceptos clave y definiciones 

El Marco de competencias de la UE 

El Marco de competencias de la UE define las competencias pertinentes para el desarrollo 
de empleados e instituciones implicados en la gestión y ejecución del FEDER y el FC. 

Afecta al Organismo de coordinación, la Autoridad de gestión y el Organismo intermedio, 
la Secretaría conjunta, la Autoridad de certificación y la Autoridad de auditoría. En la 

siguiente figura se ilustran los contenidos del Marco de competencias de la UE:  

 

Por motivos prácticos los contenidos del Marco de competencias de la UE se incluyen en 
archivos Excel independientes, uno para cada tipo de institución. La versión actual del 

Marco de competencias de la UE se incluye en el ANEXO 1: MARCO DE COMPETENCIAS 

DE LA UE. En la siguiente ilustración se presenta un extracto de ese anexo: 

 

Para cada tipo de institución, el Marco de competencias de la UE incluye: 

 Tareas y subtareas: estas se desarrollan teniendo en cuenta los reglamentos de los 

Fondos EIE para el periodo 2014-2020, los actos jurídicos nacionales y los ejemplos 

de buenas prácticas derivados de la experiencia de los distintos Estados miembros. 
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 Grupos de funciones profesionales: existen tres grupos de funciones 

profesionales, a saber, responsables de la toma de decisiones (generalmente el jefe 

de la institución del FEDER/FC), supervisores (por ejemplo, jefes de las unidades 

organizativas) y empleados de nivel operativo con distinta antigüedad; 

 Grupos de competencias: existen tres grupos de competencias, a saber, 

competencias de gestión, profesionales y operativas vinculadas a las tareas y 

subtareas que lleva a cabo cada empleado según su función profesional; 

 Las competencias operativas son aquellas necesarias para llevar a cabo las 

funciones asignadas de conformidad con los Reglamentos (p. ej., Opciones de 

costes simplificadas, Ayudas estatales);  

 Las competencias profesionales son necesarias para llevar a cabo funciones 

profesionales específicas (p. ej., Gestión de conflictos, Resolución de problemas) 

de forma eficiente;  

 Las competencias de gestión son necesarias para los empleados con funciones 

de gestión y, en cierta medida, para los empleados operativos (p. ej., Delegación, 

Liderazgo). 

 Nivel de dominio: a cada competencia se asocia una escala de dominio de 0 a 4. 

Los niveles de dominio incluidos en el Marco de competencias de la UE representan el 

objetivo de desarrollo de competencias a medio plazo para empleados e 

instituciones.  

La herramienta de autoevaluación 

La herramienta de autoevaluación está basada en web y no existen requisitos técnicos 

para su uso, con la excepción de acceso a Internet y un explorador web (p. ej., Explorer, 
Google Chrome). 

Está integrada en el Marco de competencias de la UE y su objeto es evaluar las 
competencias de los empleados y las instituciones, identificar aquellas competencias que 

o bien no existen o necesitan mejorarse, y facilitar evidencias para diseñar y ejecutar 
Planes de aprendizaje y desarrollo para la institución y cada empleado.  

Las principales etapas de funcionamiento de la herramienta son las siguientes: 

 

La herramienta de autoevaluación cuenta con un elevado nivel de flexibilidad para 
practicar evaluaciones personalizadas, basadas en las tareas y subtareas realizadas en 

una autoridad concreta:   

 La herramienta permite que los empleados seleccionen su función profesional, las 

tareas y las subtareas correspondientes y, en función de esta selección, relaciona las 

competencias que se han de evaluar conforme al Marco de competencias de la UE, 

permitiendo así una evaluación personalizada del empleado.  

 Después, el supervisor del empleado (o el responsable de la toma de decisiones 

cuando es un supervisor el que se somete a la autoevaluación) realiza una evaluación 

independiente de las competencias del empleado. El motivo por el que tiene que 

participar una segunda persona en la evaluación es para revisar la puntuación de la 

autoevaluación y ajustarla según la evaluación del supervisor.  
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 El empleado y el supervisor se reúnen en ese momento para comentar los resultados 

calculados por el sistema, que incluyen, para cada competencia evaluada, la 

autoevaluación del empleado, la evaluación del supervisor y el nivel de dominio del 

Marco de competencias de la UE. Durante esta reunión, el empleado y el supervisor 

abordan cualquier discrepancia, efectúan ajustes de la evaluación del supervisor si 

fuesen necesarios y definen las acciones de seguimiento.   

 Los resultados de cada autoevaluación se registran en la herramienta y pueden ser 

utilizados para análisis a escala de la institución. La herramienta basada en web 

ofrece dos opciones para el análisis de datos, a saber, funciones integradas para 

analizar cada competencia y plantillas de Excel semiautomatizadas para resumir 

todas las competencias de la institución. 
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3 CÓMO SE USAN LOS INSTRUMENTOS 

Para usar el Marco de competencias de la UE y la herramienta de autoevaluación es 

necesario organizar un proceso de evaluación de competencias en el seno de la 
institución. En las siguientes secciones se ofrecen pautas para organizar este proceso 

(fases, actividades, pasos) y para usar los instrumentos, en especial la herramienta de 
autoevaluación. En la siguiente ilustración se ilustran las fases y actividades necesarias 

en la evaluación de competencias: 

 

 

3.1 Fase 1: Planificación de la evaluación 

Actividad 1.1: Nombramiento del Equipo de aplicación 

La coordinación y aplicación de la evaluación de competencias no requiere un equipo 

numeroso. Se indican tres perfiles distintos, aunque en las instituciones de menor 
tamaño el mismo empleado puede asumir varios perfiles. Estos perfiles son: 

 Coordinador: el jefe de la institución o su delegado deben asumir la responsabilidad 

general sobre la ejecución de la evaluación de competencias y las acciones de 

seguimiento. 

 Gerente: supervisor de la institución del FEDER / Fondo de Cohesión, con 

responsabilidades sobre la ejecución diaria de los instrumentos. Se recomienda 

asimismo que se asignen al Gerente los derechos de usuario para gestionar la 

herramienta de autoevaluación. 

 Responsable de recursos humanos (RR. HH.): dependiendo de la configuración 

institucional, podría participar un responsable del departamento de recursos 

humanos.  

Actividad 1.2: Formación del Equipo de aplicación 

El Gerente y el Responsable de RR. HH. deben familiarizarse con los instrumentos 

mediante: 

 la familiarización con los contenidos del Marco de competencias de la UE. 

 la comprobación del funcionamiento de la herramienta de autoevaluación y las 

plantillas de análisis. 

 su asistencia a las sesiones de formación o los seminarios web que puedan ser 

organizados por la Comisión. 
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Actividad 1.3: Definición de la participación del empleado y posibles 

personalizaciones 

El Equipo de aplicación define el alcance de la evaluación en términos de participación 

del empleado, posible personalización de los instrumentos y nivel de indicaciones que se 
deben facilitar. En términos de participación del empleado, se recomienda que: 

 Todos los empleados de nivel operativo lleven a cabo su autoevaluación.  

 Todos los empleados de nivel de supervisión lleven a cabo su autoevaluación y 

evalúen las competencias de los empleados de su unidad organizativa. 

 Los responsables de la toma de decisiones participen en la evaluación de los 

supervisores y lleven a cabo su autoevaluación. 

En términos de personalización: 

 Aunque sea posible, se recomienda no modificar las tareas, subtareas, competencias 

y niveles de dominio del Marco de competencias de la UE y la herramienta de 

autoevaluación, al menos no durante el primer uso de los instrumentos. 

Con respecto a las tareas, subtareas y competencias: 

 Si se considera que un elemento no es relevante para la institución, puede 

indicarse a los empleados que no lo seleccionen. De forma alternativa, como 

se explica en el capítulo 4, es posible eliminar dicho elemento en primer 

lugar del Marco de competencias de la UE y, a continuación, de la 

Herramienta de autoevaluación. No obstante, como los pasos necesarios 

llevan tiempo, las instituciones deben analizar en detalle las ventajas de 

eliminar estos elementos. 

 Si una institución desea agregar un elemento, puede hacerlo siguiendo las 

instrucciones presentadas en el capítulo 4. Al igual que en el caso de las 

eliminaciones, añadir contenidos supone modificar en primer lugar el Marco 

de competencias de la UE y, a continuación, trasladar esos cambios a la 

herramienta de autoevaluación, por lo que se aplican las mismas 

consideraciones en términos de esfuerzo y ventajas. 

Con respecto a los niveles de dominio: 

 También los niveles de dominio pueden modificarse siguiendo las 

instrucciones explicadas en el capítulo 4. No obstante, como se pretende que 

sean objetivos a medio plazo para el desarrollo de competencias y no se 

utilizan para evaluar el rendimiento de los empleados, no se recomienda su 

modificación. 

Existen dos opciones con relación a las instrucciones facilitadas a los empleados: 

 La dirección indica a los empleados cuál es la selección de tareas, subtareas y 

competencias según las funciones de las unidades organizativas: la ventaja es que 

los resultados de la evaluación se centrarán únicamente en competencias relevantes; 

la desventaja es que no permite una visión global de las competencias de las 

instituciones. 

 La dirección permite que los empleados seleccionen las tareas, subtareas y 

competencias: la ventaja es que los resultados arrojarán una imagen global de las 

competencias de las instituciones, con la desventaja de que también se captan las 

competencias que no son relevantes. 
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 Un planteamiento útil para seleccionar la mejor opción es analizar la correlación entre 

las tareas y subtareas del Marco de competencias de la UE y las responsabilidades de 

las unidades organizativas (véase la figura siguiente): 

Tareas del Marco de competencias 
Institución 

Unidad 1 Unidad 2 Unidad 3 Unidad 4 

1. Programación     

2. Planificación del sistema     

3. Generación de proyectos     

4. Supervisión de proyectos     

5. Supervisión de programas     

6. Evaluación     

7. Nivel de gestión financiera de proyectos      

8. Nivel de gestión financiera de programas     

9. Comunicación     

10. Supervisión de Organismos intermedios     

Actividad 1.4: Elaboración de los materiales de formación y comunicación 

Esta Guía de usuario y los materiales de promoción disponibles en el sitio web de la DG 
REGIO (es decir, el folleto y la infografía) pueden utilizarse con fines de formación 

interna y comunicación. No obstante, si una administración desea desarrollar materiales 
personalizados adicionales, o instrucciones para empleados, se recomienda prepararlos 

en esta fase. 

Actividad 1.5: Definición del plan de trabajo 

Las siguientes fases pueden ejecutarse en un plazo de dos meses. A la hora de definir la 
duración y el plazo de la autoevaluación, la institución puede tener en consideración (1) 

la carga de trabajo del empleado y el cumplimiento de otros plazos de la institución; (2) 

los vínculos con otras actividades, como la elaboración de planes de formación / 
contratación.  

De igual forma, a la hora de tener en cuenta las posibles limitaciones, la institución debe 
determinar si es necesaria la asistencia externa para garantizar la ejecución eficiente de 

la evaluación. Si fuera necesaria asistencia, pueden asignarse recursos financieros del 
presupuesto de Asistencia técnica del programa.  

En el ANEXO 2: PLANTILLA DE PLAN DE TRABAJO se incluye una plantilla de plan de 
trabajo. 

3.2 Fase 2: Evaluación 

Actividad 2.1: Formación y comunicación  

Antes de iniciar la autoevaluación es recomendable llevar a cabo las siguientes 
actividades: 

 Formación de supervisores: debe efectuarla el Gerente / Responsable de RR. HH. 

y su objetivo es ofrecer a los supervisores un resumen de la finalidad y las ventajas 

de los instrumentos. La formación debe centrarse en la función de los supervisores 

en términos de revisión de la autoevaluación de los empleados, las reuniones de 

puesta en común y la participación en los análisis de resultados, según se considere 

oportuno. Se recomienda realizar esta formación como formación en aula. 

 Actividades de comunicación para empleados del nivel operativo: el objetivo 

es informar a los empleados de la finalidad y las ventajas de los instrumentos y sobre 

cómo realizar la evaluación. En términos de formato, la comunicación puede 
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desarrollarse a través de una actividad informativa o mediante los canales digitales 

de la institución (p. ej., correo electrónico, seminario web, página web). En las 

instituciones de menor tamaño, es posible organizar una actividad simultánea para 

los supervisores y los empleados. 

 Formación y comunicación personalizadas: las instituciones que hayan decidido 

indicar a los empleados cuál es la selección de tareas, subtareas y competencias, 

podrán tener en consideración la idoneidad de organizar actividades separadas por 

unidad organizativa. 

Actividad 2.2: Inicio de la evaluación de competencias 

El Gerente accede a la herramienta de autoevaluación a través de este enlace1 utilizando 

el nombre de usuario y la contraseña asignados por la DG REGIO. Esta es la «sección de 

administración» de la herramienta y contiene funciones para poner en marcha la 
evaluación, supervisar las respuestas y analizar los resultados. En la sección de 

«administración» el Gerente encuentra el formulario de autoevaluación. Al pulsar el 
botón «Share» (Compartir), el sistema creará un enlace a la herramienta de 

autoevaluación que será enviado a continuación a los empleados. 

Actividad 2.3: Autoevaluación del empleado 

Cuando sigan el enlace los empleados llegarán a la página de inicio de la herramienta de 

autoevaluación. Se recomienda que se familiaricen con los pasos de la evaluación 
descritos en esta página antes de comenzar.  

La primera vez que el empleado accede a la herramienta de autoevaluación, debe 
registrarse como nuevo usuario (sección de la izquierda), seleccionando el nombre de 

usuario y la contraseña que desee. La siguiente vez que el empleado accede a la 

herramienta, utilizará la misma información, pero accederá como usuario existente 
(sección de la derecha). 

                                          

1 https://fs26.formsite.com/form_app/FormSite?FormId=LoadLogin&Directory=sa_tools  

https://fs26.formsite.com/form_app/FormSite?FormId=LoadLogin&Directory=sa_tools
https://fs26.formsite.com/form_app/FormSite?FormId=LoadLogin&Directory=sa_tools
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La herramienta de autoevaluación genera la lista de competencias que se deben evaluar, 
de conformidad con la lógica del Marco de competencias de la UE, es decir, sobre la base 

de la función profesional, las tareas y las subtareas.  

En la página de Información básica, el empleado deberá: 

 seleccionar el Grupo de funciones profesionales (Group of Job Roles) correspondiente 

en la lista desplegable, que incluye el nivel de toma de decisiones, el nivel de 

supervisión y el nivel operativo; 

 revisar la lista de tareas y seleccionar las que sean pertinentes marcando las casillas 

correspondientes. Cuando se selecciona una tarea aparecen las subtareas. Los 

empleados del nivel operativo deben revisar la lista de subtareas y seleccionar las 

que procedan. Los empleados de los niveles de toma de decisiones y de supervisión 

no están obligados a seleccionar las subtareas; 

 el empleado del nivel operativo 

debe facilitar también 

información sobre el supervisor 

que realizará la evaluación de sus 

competencias e indicar el nombre 

del programa para el que se 

realiza la evaluación (esta parte 

es importante pues algunos 

empleados pueden participar en 

más de un programa operativo). 
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El empleado realiza la autoevaluación para la lista de competencias generadas: 

 las competencias se agrupan en tres grupos: competencias operativas, competencias 

de gestión y competencias profesionales; 

 los empleados evalúan cada competencia en función de la escala de dominio de la 

herramienta de autoevaluación. La escala va de 0 a 4 y existe una opción «No 

procede» que deben utilizarla los empleados cuando consideren que una competencia 

no es necesaria: el uso de esta opción permitirá centrar más la evaluación y las 

actividades de desarrollo 

Nivel Descripción del dominio 

N.P. No procede La competencia no procede para la función profesional y no debe evaluarse. 

Nivel 0. Sin 

conocimientos  

Sin conocimientos de la competencia.  

Sin capacidad para aplicar los conocimientos. 

Nivel 1. Concienciación 

Conocimientos básicos de la competencia (p. ej., conceptos generales).  

Capacidad básica para aplicar los conocimientos a las tareas diarias (p. ej., 

identificar e investigar aspectos, comprensión e interpretación de 

documentación y situaciones). 

Nivel 2. Con formación 

Buenos conocimientos de trabajo de la competencia.  

Capacidad para aplicar conocimientos a las tareas diarias (p. ej., identificar 

aspectos críticos, proponer soluciones y elaborar la documentación relevante). 

Nivel 3. Intermedio  

Conocimientos profundos de la competencia. 

Amplia capacidad para aplicar conocimientos en tareas diarias (p. ej., asesorar 

a terceros, desarrollar nuevos planteamientos, seleccionar el curso de acción 

adecuado en un contexto general) 

Nivel 4. Experto 

Amplios conocimientos especializados y capacidades con respecto a la 

competencia. 

Capacidad para resaltar las ventajas y desventajas de cada uno de los procesos 

relacionados con la competencia y vincularlos a una visión más general. 

Capacidad para ofrecer asesoramiento personalizado y justificar ese 

asesoramiento con argumentos específicos relevantes y contextuales en 

respuesta a consultas internas y externas. 

Considerado por terceros como un modelo a seguir que es capaz de liderar o 

enseñar a otros en el campo de la competencia 

Una vez completada la autoevaluación de cada grupo de competencias, el empleado 

puede facilitar comentarios cualitativos adicionales en un campo de texto. Nota: Si no 
hay comentarios, el empleado debe hacer constar «No comment» (Sin comentarios). 
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                Nota: Si no se completa alguna sección aparece un mensaje de «error». 

Si el empleado necesita interrumpir la autoevaluación en cualquier momento, al final de 
cada página hay un botón «SAVE PROGRESS» (GUARDAR EL PROGRESO). Para regresar 

a la autoevaluación, el empleado deberá utilizar el enlace guardado e iniciar sesión como 
usuario existente (véase el paso 3). 

 

Una vez el empleado ha completado la autoevaluación para todas las competencias, se le 

notifica la finalización de su parte y se le invita a comunicar el nombre de usuario y la 

contraseña al supervisor correspondiente. 
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Actividad 2.4: Evaluación de empleados por parte del supervisor 

El supervisor inicia sesión en la herramienta de autoevaluación para llevar a cabo la 
evaluación de las competencias del empleado, iniciando sesión como usuario existente 

con el nombre de usuario y la contraseña facilitada por el empleado. 

Las evaluaciones del supervisor y del empleado se llevan a cabo en distintas páginas de 
la herramienta de autoevaluación. Una vez iniciada sesión, el supervisor debe dirigirse a 

la sección del supervisor para la evaluación.  Aunque los resultados del empleado son 
visibles, no se deben consultar para evitar el sesgo. 

 

El supervisor lleva a cabo la evaluación de las competencias del empleado.  

 

 

 

 

 

 

 

 

 

 

 

 

Una vez finalizada la evaluación aparece una página de separación que señala la 

finalización de la evaluación. El supervisor guarda los resultados, comunica al empleado 
la finalización de la evaluación, y programa una reunión con este. 
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Actividad 2.5: Resultados de la evaluación y reunión de puesta en 

común  

El empleado y el supervisor se reúnen para comentar los resultados de la evaluación de 
competencias.  

Se recomienda que esta puesta en común sea una reunión en persona.  

 El objeto de esta reunión es analizar los resultados de la autoevaluación, identificar 

las áreas que muestran fortalezas y aquellas con posibilidad de mejora, así como 

llegar a un acuerdo sobre las acciones de seguimiento para el desarrollo de 

competencias. 

 Los resultados de la evaluación se muestran en términos de autoevaluación del 

empleado; evaluación del supervisor; nivel de dominio deseado predefinido en la 

herramienta, que representa el objetivo de desarrollo de la competencia a medio 

plazo. 

 En caso de que se produzca alguna discrepancia significativa entre las evaluaciones 

del supervisor y del empleado, deben ajustarse los resultados de la evaluación.  

 Es importante que este ajuste quede reflejado en la evaluación del supervisor, pues 

esta se mostrará en los informes de evaluación individual y aparecerá en el cálculo 

de los resultados a nivel de la institución. 
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Una vez finalizada esta reunión, pueden introducirse en el sistema las conclusiones 

relativas a las áreas que muestran fortalezas y aquellas con posibilidad de mejora.  
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El supervisor confirma en ese momento que se han rellenado correctamente todos los 

campos, pulsa «Next» (Siguiente), tras lo que aparece la página «Submit» (Enviar). Una 
vez se pulse el botón para enviar, ya no se pueden editar los resultados. 

 

 

Actividad 2.6: Generación de informes de evaluación individual 

El Gerente accede a la zona de administración de la herramienta y hace clic sobre el 

botón «Results» (Resultados). 

 

En la nueva pantalla, el Gerente puede observar la lista de evaluaciones individuales 

completadas que están marcadas con «estado verde».  

Para enviar el informe de evaluación individual, el Gerente selecciona en primer lugar 

«Individual» en el menú desplegable de la parte superior derecha de la página y, a 

continuación, pulsa sobre el icono del sobre a la izquierda del nombre de usuario del 
empleado. 
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En la pantalla «Email results» (Enviar resultados 

por correo electrónico) que aparece a 
continuación, el Gerente completa los campos 

según se indica en la imagen de pantalla: 

 Correo electrónico: dirección de correo 

electrónico del empleado 

 Notificación: Personalizada 

 Formato: PDF de resultados 

 PDF de resultados: Cuadro 

 Vista de resultados: Informe individual 

 Insertar mensaje (opcional) 

 Pulse «Send» (Enviar) 

 

 

 

 

 

Los resultados de la evaluación individual muestran los tres valores tratados durante la 

reunión de puesta en común entre el empleado y el supervisor, a saber: autoevaluación, 
evaluación del supervisor y nivel de dominio deseado. Para que destaque más la 

evaluación del supervisor, el informe individual muestra esta en una columna 

independiente a la derecha (véase la imagen) 

 

 

Nota: Las competencias marcadas como «No procede» (N.P.) por el supervisor aparecen 
en el informe como un número en el intervalo 107-110. 
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3.3 Fase 3: Análisis y elaboración del plan de aprendizaje y desarrollo 

Actividad 3.1: Elaboración de análisis a escala institucional 

El Gerente inicia sesión en la herramienta de autoevaluación y accede a la página de 

«Resultados».  

Desde esta sección pueden realizarse dos análisis a escala institucional: por competencia 

individual y por total de competencias. 

Análisis a escala institucional por competencia individual 

Haga clic sobre el botón «Analytics» (Análisis) y, a continuación, «Item Summary» 

(Resumen de elementos), y seleccione una competencia en la lista. Para la competencia 
seleccionada, se genera un cuadro que describe la distribución de empleados (que hayan 

realizado una evaluación para esta competencia) según el nivel de dominio evaluado por 
el supervisor.  

Por ejemplo, en el cuadro siguiente relativo a la competencia MA.O.C1. Actos jurídicos 

nacionales / de la UE relativos a los Fondos EIE, hay 7 empleados con un nivel de 
dominio evaluado de 1, 60 con un nivel de dominio evaluado de 2 y 32 con un nivel de 

dominio evaluado de 3. 

Es posible limitar el análisis de una competencia individual por tarea haciendo clic sobre 

el botón «Analytics» (Análisis) y, a continuación, «Cross-Tabulation» (Tabulación 

cruzada). Como la misma competencia está asociada a varias tareas, este análisis es 
relevante, por ejemplo, para el supervisor de una unidad organizativa determinada que 

desea analizar el dominio de empleados de la unidad en relación con una competencia 
específica. 

Para ello, pulse el botón «Cross-Tabulation» (Tabulación cruzada) y, a continuación, en 
«Question A» (Pregunta A) seleccione una tarea y en «Question B» (Pregunta B) una 

competencia. Por ejemplo, en el cuadro siguiente se muestran los resultados de la 
evaluación para la competencia MA.O.C1. Actos jurídicos nacionales / de la UE relativos a 

los Fondos EIE, únicamente para los empleados que llevan a cabo la tarea «Monitoring 

on Programme level» (Seguimiento a nivel de programa).  
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En el cuadro se muestra información sobre los resultados por subtarea, así que, por 

ejemplo, para la subtarea «Measuremente of the performance of the PA/Measure 
(planning, monitoring, forecasting, revising)» [Medición de los resultados de actividades 

del programa/medida (planificación, seguimiento, previsión, revisión)], hay un empleado 
con un nivel de dominio 1, 2 empleados con un nivel de dominio 2 y 1 empleado con un 

nivel de dominio 3. 

 

Análisis a escala institucional por total de competencias 

El objeto es obtener un análisis a escala institucional de todas las competencias 

mediante la agregación de los resultados de la evaluación de competencias individuales 
de todos los empleados. Esto se consigue extrayendo los datos en bruto en formato 

Excel de la Herramienta de autoevaluación y pegándolos en una plantilla Excel 
semiautomatizada (véase «Institution_analysis_Template» (Plantilla para análisis de la 

institución) incluida en el ANEXO 4: PLANTILLAS DE ANÁLISIS A NIVEL DE LA 
INSTITUCIÓN) 

Se descargan dos conjuntos independientes de datos en bruto: sobre los empleados 

operativos y los empleados no operativos (supervisores y responsables de decisiones) 
respectivamente, que se pegan en distintas hojas de cálculo de las plantillas para 

análisis de la institución. 

 

Para descargar los datos en bruto se 
deben realizar las siguientes acciones: 

 En el menú de la derecha de la 

página de Resultados, haga clic 

sobre «Export» (Exportar). 

 En el menú desplegable de «Results 

View» (Vista de resultados), elija 

«Institution Report» (Informe de la 

institución).  

 En «Results Filter» (Filtro de 

resultados), elija «Operational» 

(Operativos) para seleccionar datos 

relacionados con los empleados de 

nivel operativo y «Non-Operational» 

(No operativos) para seleccionar los 
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datos relacionados con los restantes empleados. 

 Pulse el botón verde «Export» (Exportar) para descargar los resultados en Excel. 

 Para recibir los resultados a través de correo electrónico, haga clic sobre la opción 

«Email me» (Enviarme un correo electrónico), introduzca la dirección de correo 

electrónico y pulse «Export» (Exportar). 
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Una vez reciba los archivos Excel sobre empleados 

operativos y no operativos: 

 Guarde los archivos Excel. 

 Abra cada archivo y copie los resultados haciendo 

clic sobre la celda A1 y pulsando CTRL+SHIFT+ 

 + .  

 Pegue los datos copiados en la respectiva hoja de 

cálculo de la plantilla Excel semiautomatizada. 

 Al pegar los datos en bruto en la plantilla, se 

generan dos informes de evaluación de la 

institución.  

El primer análisis presenta, para cada competencia evaluada, el número total de 

empleados evaluados y su distribución en función de la evaluación del supervisor. Así se 
obtiene una imagen clara del nivel general de desarrollo de competencias en la 

institución; no obstante, no se aporta información sobre los objetivos de desarrollo a 
medio plazo de los empleados, lo que complica más la identificación de las acciones de 

desarrollo más adecuadas. 

 

El segundo tipo de análisis es más completo pues tiene en cuenta que el nivel de 

dominio deseado puede variar en función de la selección de tareas y subtareas efectuada 
por los empleados. Por tanto, la distribución de empleados en función del nivel de 

dominio2 evaluado tiene en consideración el nivel deseado de dominio de cada 
empleado.  

 

A modo ilustrativo, en el ejemplo de la figura anterior, hay un total de seis empleados 
con un nivel de dominio deseado previsto de 2 en la competencia operativa «MA.O.C43 

Conocimientos de ingeniería pertinentes para el sector». Tres de estos seis empleados ya 
han alcanzado el objetivo de desarrollo a medio plazo, y otros tres ya lo han superado. 

 

 

 

                                          

2 Como antes, el nivel de dominio evaluado por el supervisor para los empleados de nivel operativo y el nivel 

de dominio evaluado por el responsable de las decisiones para los supervisores. 

Assessed  level 

0

Assessed level 

1

Assessed  level 

2

Assessed  level 

3

Assessed  level 

4

MA.O.C39
ESIF EU/ National legal acts - 

communication
0 0 0 0 0 0

MA.O.C40
Identification of different stakeholders 

and their information needs
0 0 0 0 0 0

MA.O.C41 Management of relevant media 0 0 0 0 0 0

MA.O.C42 Web communication 0 0 0 0 0 0

O
p
e
ra

ti
o
n
a
l

Competencies
Total 

assessed 

employees

Number of employees by supervisor assessed proficiency level

0 1 2 3 4 0 1 2 3 4 0 1 2 3 4 0 1 2 3 4

MA.O.C41 Management of relevant media 2 0 0 0 0 0 2 0 0 0 0 0 0 0 0 0 N/A N/A N/A N/A N/A

MA.O.C42 Web communication 0 0 0 0 0 0 N/A N/A N/A N/A N/A 0 0 0 0 0 N/A N/A N/A N/A N/A

MA.O.C43
Knowledge of Engineering relevant 

for the sector
11 N/A N/A N/A N/A N/A 0 0 3 3 0 0 1 3 1 0 N/A N/A N/A N/A N/A

MA.O.C44
Audit standards, procedures and 

methodologies
0 N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A 0 0 0 0 0 N/A N/A N/A N/A N/A

Competencies
Desired level 1

O
p
e
ra

ti
o
n
a
l

Desired level 2 Desired level 3 Desired level 4

Number of employees by sypervisor assessed proficiency level

Total 

assessed 

employees
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Actividad 3.2: Análisis de resultados y priorización de acciones  

El objetivo es identificar las competencias que las instituciones pretenden mejorar y 
cómo, sobre la base de las pruebas incluidas en los análisis de evaluación de la 

institución.  

Para esta actividad, es de importancia clave la implicación activa de la dirección de la 

institución. La actividad requiere un conocimiento en profundidad de la institución y del 

contexto de ciclo de vida de la programación (por ejemplo, estado actual, actividades 
previstas, desafíos). 

No existe un único planteamiento o metodología universal para la priorización de 
competencias. Se recomienda llevar a cabo un análisis sistemático de los resultados de 

cada competencia y seleccionar las competencias que deben desarrollarse más. 

Una vez se identifiquen las competencias, el siguiente paso es seleccionar el 

planteamiento más adecuado para el desarrollo de competencias. Entre las opciones se 
encuentran la formación, la contratación, la externalización (uso de expertos externos), 

la automatización de procesos mediante la robótica, y la participación en redes de 

aprendizaje y aprendizaje de buenas prácticas, incluido el aprendizaje entre iguales.   

Para facilitar la selección de acciones y métodos de desarrollo de competencias, se ha 

desarrollado un marco metodológico, presentado en la ilustración siguiente: 

  

Los principios del marco metodológico se resumen de la siguiente forma: 

 La formación es la opción preferida para el desarrollo de competencias. La 

selección del método de formación más apropiado debe tener en cuenta el nivel de 

dominio que se ha de alcanzar. Los niveles de dominio más elevados se asocian a 

métodos más interactivos. Para ello, la referencia teórica se representa mediante la 

taxonomía de resultados del aprendizaje de Bloom: 

Método de aprendizaje Definición 

Para alcanzar el nivel 3 y 4 en la competencia 

Programas de 

aprendizaje basados 

en la intervisión 

La intervisión es un método de autoayuda empleado entre compañeros o pares 

para ayudarse entre sí a superar los desafíos que encuentra una persona en su 

trabajo. A veces se dispone de un moderador.  

Aprendizaje en el 

trabajo 
Un planteamiento de «aprender haciendo» de manera individual en el que el 

empleado aprende nuevas competencias en una situación laboral habitual. El 
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Método de aprendizaje Definición 

empleado recibe retroalimentación directamente mientras lleva a cabo las 

tareas. La persona que se encarga de la formación del empleado observa, 

instruye y aporta comentarios.  

Asesoramiento y apoyo 

al rendimiento 

Apoyo individual en el lugar de trabajo con respecto a cuestiones de 

funcionamiento técnicas o personales. Este apoyo puede estar disponible 

internamente (prestado por un director u otra persona de la organización) o 

externamente (orientador externo). 

Debates moderados 

con expertos 

Una acción en la que los empleados tienen la posibilidad de abordar desafíos 

técnicos en su trabajo y recibir orientación, consejos, trucos y soluciones para 

estos desafíos. 

Para alcanzar el nivel 2 en la competencia 

Trabajos (virtuales) en 

el aula 

Un grupo de empleados que desean aprender más sobre determinadas 

competencias. Se reúnen físicamente en un espacio o de forma virtual.  

Trabajos en grupo 
Un grupo de empleados recibe un trabajo que deben completar de forma 

conjunta. 

Ludificación interactiva 

La ludificación interactiva es el proceso de aplicar a la formación diseños y 

conceptos de juegos con el fin de hacerla más atractiva para el alumno. Los 

alumnos compiten directamente contra una o más personas o participan de 

manera individual en una experiencia interactiva que gratifica de alguna forma 

el aprendizaje. 

Para alcanzar el nivel 1 en la competencia 

Aprendizaje basado en 

web 

Un archivo de curso ejecutable que puede enviarse por correo electrónico y 

ejecutarse de forma independiente en un PC o cargarse en un Sistema de 

gestión de aprendizaje debidamente configurado. Permite el aprendizaje a 

distinto ritmo, con contenidos de texto, gráficos estáticos, animaciones e 

interacciones periódicas con fines de motivación y recuerdo. 

Presentación 

interesante  

Un método interactivo para atraer a un grupo de personas al debate en torno a 

un tema. Puede ser en forma de discusión, debate, narración, sesión de 

preguntas y respuestas, etc.  

En la organización de la formación existen dos opciones: asistencia a eventos de 

formación existentes u organización de eventos personalizados para la institución. La 
elección debe efectuarse teniendo en cuenta la optimización de recursos sobre la base de 

1) relevancia, y 2) coste (personas que se van a formar * coste de la formación por 
participante). 

 La contratación se recomienda cuando el nivel de desarrollo actual de una 

competencia es bajo en comparación con el deseado y existe una necesidad urgente 

de eliminar dicha deficiencia. La contratación debe tenerse en consideración 

principalmente para internalizar recursos con un nivel de dominio de 3 o 4 para 

solventar la inexistencia de una competencia específica que no se puede resolver 

rápidamente por medio de la formación. 

 La externalización, entendida como la contratación de expertos externos 

para solventar deficiencias de competencias específicas, debe tenerse siempre en 

consideración en correlación con una o más tareas o subtareas. Para las tareas 

estratégicas, la institución puede tener en consideración la externalización 

únicamente como solución provisional hasta que se produzca un desarrollo suficiente 

de las competencias internas. Es asimismo recomendable que se incluyan las 

actividades de desarrollo de competencias en el alcance de la externalización. En el 

caso de las tareas no estratégicas, la externalización puede considerarse una opción 

a largo plazo, pero debe desarrollarse asimismo un nivel mínimo de dominio dentro 

de la institución. 

 La automatización de procesos mediante la robótica es la introducción de 

programas informáticos personalizados para llevar a cabo subtareas repetitivas. 

Teniendo en cuenta las necesidades de cohesión electrónica en el intercambio de 

datos electrónicos y la naturaleza de las subtareas, la automatización de procesos 

mediante la robótica podría tener una aplicación en relación con aspectos específicos 

de la valoración de proyectos, la comprobación administrativa y de 
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subvencionabilidad y la verificación de solicitudes de pago. Debe desarrollarse un 

caso de uso para evaluar el potencial de aplicación específico de antemano, por lo 

que las instituciones no deberían tener en consideración esta opción para abordar las 

deficiencias en competencias de mayor urgencia. 

 Participación en redes de aprendizaje: Existen varias redes de aprendizaje 

vinculadas a las competencias, establecidas a escala europea y gestionadas bien por 

la Comisión o por instituciones académicas3. La participación debe tenerse en 

consideración como opción de aprendizaje alternativa a las destacadas con 

anterioridad. 

 Buenas prácticas: Existen buenas prácticas en el desarrollo de competencias 

disponibles en el sitio web de la DG REGIO4. De igual forma que en la participación 

en redes de aprendizaje, la adopción de buenas prácticas, incluso a través del 

aprendizaje entre iguales, debe considerarse una opción de aprendizaje 

complementaria. 

Como resultado de la actividad, se recomienda agregar a la «Plantilla de análisis a nivel 

institucional» la lista de competencias seleccionadas para mejora y el método de 
aprendizaje seleccionado, a ser posible con un calendario de ejecución. Esa información 

se presentará a continuación a un grupo más grande de partes interesadas de la 

institución, como se describe en la actividad siguiente. 

Código Competencia 
Total de 
empleados 

evaluados 

Nivel 1 

evaluado 

Nivel 2 

evaluado 

Nivel 3 

evaluado 

Nivel 4 

evaluado 

Seleccionada 
para 

desarrollo 

Método de 
desarrollo 

de 

competencia 

Calendario 

MA.O.C1 

Actos jurídicos 
nacionales / de la UE 

relativos a los Fondos 

EIE  

    
 

SÍ Formación T3 2018 

MA.O.C2 

Documentos estratégicos 

nacionales (por ejemplo, 
estrategias nacionales de 

desarrollo, políticas 

temáticas y sectoriales 
pertinentes) 

    

 
   

MA.O.C3 

Normas en materia de 
subvencionabilidad de los 

gastos contempladas en 

actos jurídicos, 
directrices y 

metodologías nacionales 
y de la UE, incluido el 

alcance de la asistencia 

    

 

   

 

Actividad 2.3: Taller de debate de los resultados.  

El objeto de esta actividad es poner en común los resultados de la evaluación de 

competencias y las acciones de desarrollo competencial previstas con un grupo más 
grande de partes interesadas de la institución para obtener el refrendo de los 

responsables políticos.  

En el taller pueden participar los centros educativos de administración pública nacionales 

con el fin de ayudar a identificar las ofertas de formación relevantes para las 
necesidades de las instituciones. 

Actividad 2.4: Elaboración del Plan de aprendizaje y desarrollo 

Al final de la evaluación, se recomienda a las instituciones que elaboren un Plan de 
aprendizaje y desarrollo en el que sinteticen los resultados de la evaluación y las 

acciones de seguimiento previstas con respecto al desarrollo de competencias. 

                                          

3 http://ec.europa.eu/regional_policy/sources/docgener/studies/pdf/comp_fw/eu_comp_fw_report_en.pdf 
4 http://ec.europa.eu/regional_policy/sources/docgener/studies/pdf/comp_fw/eu_comp_fw_annex7_en.pdf 
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Será una buena práctica adaptar la planificación de recursos del presupuesto de 

Asistencia técnica del programa operativo gestionado/ejecutado por la institución a las 
actividades incluidas en el Plan de aprendizaje y desarrollo. La plantilla del Plan de 

aprendizaje y desarrollo se incluye en el ANEXO 3: PLANTILLA DEL PLAN DE 
APRENDIZAJE Y DESARROLLO y engloba: 

 Alcance y metodología de la autoevaluación 

 Resultados de la evaluación de competencias a nivel de la institución. 

 Acciones inmediatas para el desarrollo de competencias: métodos y acciones de 

aprendizaje seleccionadas para solventar las deficiencias en materia de competencias 

y su calendario de ejecución. 

 Consideración sobre cómo utilizar la herramienta en el futuro, incluidos los aspectos 

de responsabilidad, procedimientos de ejecución y necesidades de recursos. 

 Aplicación de una hoja de ruta para acciones inmediatas y preparación para uso 

futuro. 

En la elaboración del Plan, las instituciones pueden reflejar también si hay algún ajuste 
de la estructura organizativa que debe tenerse en consideración sobre la base de la lista 

de tareas y subtareas contempladas en el Marco de competencias de la UE. Esto 
permitiría una mayor claridad en las asignaciones de funciones y responsabilidades entre 

las unidades organizativas. 
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4 CÓMO SE PERSONALIZAN LOS INSTRUMENTOS 

4.1 Personalización del Marco de competencias de la UE 

Si una institución tiene intención de personalizar los instrumentos, se recomienda 
documentar todos los cambios en primer lugar en la versión en Excel del Marco de 

competencias de la UE.  

 

En términos prácticos, llevar a cabo una personalización conlleva los siguientes pasos: 

 Si se añade una nueva tarea: el primer paso es detallar las subtareas y, a 

continuación, asociar las competencias existentes y las nuevas competencias así 

como asignar niveles de dominio para todas las funciones profesionales. 

 Si se añade una nueva subtarea: el primer paso es asociar las competencias 

existentes y las nuevas competencias así como asignar niveles de dominio para todas 

las funciones profesionales. 

 Si se añade una nueva competencia: debe asociarse a subtareas existentes para 

empleados de nivel operativo y también para las restantes funciones profesionales. 

 Si se tienen que modificar los niveles de dominio, puede hacerse simplemente 

sustituyendo los niveles existentes por otros nuevos. 

 También se recomienda que se haga un seguimiento visual de todos los cambios en 

el archivo. 

4.2 Personalización de la herramienta de autoevaluación 

4.2.1 Cómo añadir o editar tareas 

Necesario 

 Acceso del Gerente a la Herramienta de autoevaluación 

 Marco de competencias de la UE 

Instrucciones 

1. Inicie sesión en Formsite y pulse el botón «Edit» (Editar) en su ficha de la institución 

Preparation of the 

Programme 

Definition of the 

guiding principles 

for selection of 

operations 

Management of 

the evaluation 

process (ex-ante)

NEW SUB-TASK
Negotiation with 

the EC

Procurement of 

goods and 

services under 

Technical 

Assistance

MA.O.C1 ESIF EU/  Nat ional legal acts - general 4 4 2 4 2 3 3

MA.O.C2

Nat ional st rategic documents (e.g. Nat ional 

Development  St rategies, relevant  themat ic 

and sectoral policies)

4 4 2 4 1 3 3

NEW COMPETENCY

NEW 

PROFICIENCY 

LEVEL

MA.O.C3

ESIF EU/  Nat ional legal acts - eligibilit y of 

expenditure (rules, guidelines and 

methodologies, including the scope of 

support )

4 2 4 3 3 3

MA.O.C4

Territorial issues, such as ITI, CLLD, 

Sustainable urban development , 

macro/ regional st rategies and interregional 

cooperat ion planning

3 2 3 3 2

Operat ional Competencies

Operat ional level

Supervisory level
Decision making 

level

Programming
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2. Pase el cursor sobre la casilla «Tasks» (Tareas) y pulse el botón «Edit» (Editar) en la 

esquina inferior izquierda 

3. En «Edit Choices» (Editar opciones), pulse el botón redondo + para agregar una 

nueva tarea O pulse el botón del lápiz para editar el nombre de una tarea 

4. Pulse el botón verde «Save» (Guardar) en la parte inferior de la ventana  

5. La tarea que ha agregado o editado aparecerá en su ficha  

Nota: Si no desea agregar subtareas, vaya directamente al paso 11. 

6. Para agregar una nueva lista de subtareas, en el menú «Common Items» 

(Elementos comunes) de la izquierda, pulse y arrastre una «Checkbox» (Casilla de 

verificación) a cualquier lugar bajo el encabezado «Subtasks» (Subtareas) 

7. En la ventana «Checkbox» (Casilla de verificación), en el apartado «Choices» 

(Opciones), haga clic sobre «Edit Choices» (Editar opciones). Pulse el botón + para 

agregar una subtarea o borre el texto «Choice A» o «Choice B» y nombre las 

subtareas adicionales. 

8.  Una vez agregadas todas las subtareas, pulse el botón verde «Save» (Guardar) en la 

parte inferior.  

9. Pase el cursor sobre 

la casilla de texto «Added» 

(Añadido) y pulse el botón 

«Edit» (Editar) 

10. En la barra superior, 
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pulse «Rules» (Reglas). En las opciones desplegables en la parte inferior, seleccione 

«Tasks» (Tareas) «is» (es) y «Added task example» (Ejemplo de tarea agregada) (al 

hacer esto se establece una «regla» según la cual esta casilla aparecerá únicamente 

cuando se seleccione el «Ejemplo de tarea agregada» en el menú Tareas). 

11. Para determinar las competencias relacionadas con las nuevas subtareas, tendrá que 

configurar las «reglas» para cada una de las competencias. Para ello, desplácese 

hasta la página 3, pase con el cursor sobre las competencias que le gustaría agregar 

a las nuevas tareas y subtareas y haga clic sobre el botón «Edit» (Editar) 

12. En la barra superior, pulse «Rules» (Reglas). Añada una nueva regla pulsando el 

botón verde + y elija la regla pertinente [en nuestro ejemplo, aparecería MA.O.C5 

cuando «ejemplo de tarea agregada» es «subtask 1» (subtarea 1)]  

13. Repita el proceso para todas las competencias relevantes de la sección «Self-

assesment» (Autoevaluación)  

14. Para agregar una evaluación del supervisor, desplácese hacia abajo hasta el apartado 

de autoevaluación y repita el mismo proceso para las mismas competencias que ha 

elegido en el anterior paso 

15. Para determinar el nivel deseado en relación con cada competencia, desplácese hacia 

abajo hasta la página de resultados (9) y elija el nivel deseado pertinente para cada 

competencia. Ejemplo: Si la subtarea 1 requiere un dominio de nivel 3 en MA.O.C5. 

Ayudas estatales, pase con el cursor sobre la casilla correspondiente y pulse el botón 

«Edit» (Editar) 

16. En la barra superior, haga clic sobre «Rules» (Reglas) y agregue una nueva regla 

añadiendo la opción pertinente de los menús desplegables. A continuación, pulse el 

botón «Save» (Guardar) 
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17. Repita este proceso para cada una de las competencias agregadas y sus niveles 

deseados correspondientes 

Nota: En caso de que desee editar una tarea o una subtarea, recuerde que cada una de ellas está 

«conectada» a un conjunto específico de competencias, que se indican en la hoja de cálculo del 
Marco de competencias de la DG REGIO. Si desea adaptar la tarea editada a los nuevos requisitos, 
asegúrese de modificar también las competencias «conectadas». 

4.2.2 Cómo modificar los niveles de dominio deseados 

Pongamos por ejemplo que un empleado que lleva a cabo la subtarea «Preparación del 

programa» (en la tarea de Programación) presenta un nivel 3 de dominio deseado en la 
competencia MA.O.C5. Ayudas estatales. En caso de que decida que el nivel de dominio 

de esta competencia debe ser 2 y no 3, siga las instrucciones siguientes para efectuar 
los cambios necesarios.   

Necesario 

1. Acceso del Gerente a la página de la institución en Formsite 

2. Marco de competencias de la UE 

Instrucciones 

1. Inicie sesión en Formsite y pulse el botón «Edit» (Editar) en su ficha de la institución 

2. Desplácese hasta la página de resultados (página 9) y pase el cursor sobre la casilla 

Nivel deseado 3 de MA.O.C5, y pulse el botón «Edit» (Editar) 

3. En la barra superior, haga clic sobre «Rules» (Reglas) 

4. Identifique la «Regla» que desea modificar y haga clic sobre el botón «-» para 

eliminarla; a continuación, pulse el botón verde «Save» (Guardar) en la parte inferior 

5. Para «vincular» el Nivel deseado 2 de MA.O.C5 con la subtarea en cuestión, pase el 

cursor sobre la casilla del Nivel deseado 2 de MA.O.C5 y haga clic sobre el botón 
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«Edit» (Editar) 

6. Desde la barra superior, haga clic sobre «Rules» (Reglas) y, a continuación, sobre 

«+» en cualquier «regla» para añadir la regla deseada 

7. Introduzca la nueva regla eligiendo las opciones pertinentes en el menú desplegable 

[en nuestro ejemplo «Programming» (Programación), se trata de «Preparation of 

programme» (Preparación del programa)] y, a continuación, pulse «Save» (Guardar).  

       

4.2.3 Agregar competencias   

Necesario 

1. Acceso del Gerente a la página de la institución en Formsite 

2. Marco de competencias de la UE 

Instrucciones 

1. Agregue la competencia en cuestión al Marco de competencias de la UE y determine 

los niveles deseados para las subtareas correspondientes, según sea necesario 
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2. Inicie sesión en Formsite y pulse el botón «Edit» (Editar) en su ficha de la institución 

3. Desplácese hasta las páginas de autoevaluación (operativo/gestión/profesional), pase 

con el ratón sobre la última competencia de esa categoría y haga clic sobre el botón 

«Copy» (Copiar) 

4. Pase el cursor sobre la competencia copiada y haga clic sobre el botón «Edit» (Editar) 

5. Edite el nombre de la competencia para mostrar el nombre nuevo (imagen de la 

derecha) 

 

3. Desde la barra superior, haga clic sobre «Rules» (Reglas) y utilice los signos «-» y 

«+» para eliminar o agregar a la nueva competencia las subtareas pertinentes 

(según los valores que ha añadido al Marco de competencias de la UE) 

6. Haga clic sobre el botón verde «Save» (Guardar)  

7. Pase con el cursor sobre la competencia recién agregada y haga clic sobre el botón 

«Copy» (Copiar) 
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8. Pulse, arrastre y suelte la competencia copiada en la sección correspondiente de 

evaluación del supervisor (dos páginas más abajo).  

9. Para establecer el nivel deseado de la competencia recién agregada, desplácese a la 

categoría pertinente para la competencia en la sección de resultados 

(operativo/gestión/profesional, páginas 9-10)  

10. Pase el cursor sobre la última casilla de resultados de la página y pulse el botón 

«Copy» (Copiar) 

11. Pase el cursor sobre la casilla de resultados copiada y pulse el botón «Edit» (Editar) 

12. Edite la información sobre la competencia, incluido el nivel de dominio, para mostrar 

el correspondiente a la recién agregada 

13. Desde la barra superior, haga clic sobre «Rules» (Reglas) y, a continuación, sobre 

«+» en cualquier «regla» para añadir la regla deseada  
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14. Desde la barra superior, haga clic sobre «Rules» (Reglas) y utilice los signos «-» y 

«+» para eliminar o agregar a la nueva competencia las subtareas pertinentes 

(según los valores que ha añadido al Marco de competencias de la UE)  

Nota: Si elige editar el nombre de una competencia existente, recuerde revisar los niveles de 
dominio deseados correspondientes en la sección de resultados y ajustarlos debidamente. 



Guía de usuario para el Marco de competencias de la UE y la herramienta de autoevaluación 
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ANEXO 1: MARCO DE COMPETENCIAS DE LA UE 

Véanse los archivos separados 

1a Marco de competencias para el Organismo de coordinación 

1b Marco de competencias para la Autoridad de gestión y el Organismo intermedio 

1c Marco de competencias para la Secretaría conjunta 

1d Marco de competencias para la Autoridad de certificación 

1e Marco de competencias para la Autoridad de auditoría 

 

 



Guía de usuario para el Marco de competencias de la UE y la herramienta de autoevaluación 
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ANEXO 2: PLANTILLA DE PLAN DE TRABAJO 

Estado en:    

    

 
  

    
              Fase  Tareas 

Mes 1 Mes 2 Mes 3 

S1 S2 S3 S4 S1 S2 S3 S4 S1 S2 S3 S4 

Fase 1: 
Creación 

Actividad 1.1: Nombramiento del 
Equipo de aplicación 

                        

Actividad 1.2: Formación del Equipo 
de aplicación 

                        

Actividad 1.3: Definición de la 
participación del empleado y posibles 

personalizaciones 

                        

Actividad 1.4: Elaboración de 
materiales y plantillas 

                        

Actividad 1.5: Definición del plan de 
trabajo 

                        

Fase 2: 
Autoevaluación 

Actividad 2.1: Formación y 

comunicación  
                        

Actividad 2.2: Inicio de la evaluación 

de competencias 
                        

Actividad 2.3: Autoevaluación del 

empleado 
                        

Actividad 2.4: Evaluación de 
empleados por parte del supervisor 

                        

Actividad 2.5: Resultados de la 
evaluación y reunión de puesta en 

común 

                        

Actividad 2.6: Generación de informes 
de evaluación individual 

            

Fase 3: 

Análisis y 
elaboración del 
Plan de 
aprendizaje y 

desarrollo 

Actividad 3.1: Elaboración de análisis 
a escala institucional 

                        

Actividad 3.2: Análisis de resultados y 

priorización de acciones  
                        

Actividad 3.3: Taller de debate de los 

resultados.  
                        

Actividad 3.4: Elaboración del Plan de 
aprendizaje y desarrollo 
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ANEXO 3: PLANTILLA DEL PLAN DE APRENDIZAJE Y DESARROLLO 

Véase el archivo separado 
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ANEXO 4: PLANTILLAS DE ANÁLISIS A NIVEL DE LA INSTITUCIÓN 

 

Véanse los archivos separados 

1a Plantilla de análisis para el Organismo de coordinación 

1b Plantilla de análisis para la Autoridad de gestión y el Organismo intermedio 

1c Plantilla de análisis para la Secretaría conjunta 

1d Plantilla de análisis para la Autoridad de certificación 

1e Plantilla de análisis para la Autoridad de auditoría 
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